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CHAPTER 1 
INTRODUCTION, 

MOTORMONITOR DESCRIPTION, 
SOFTWARE & HARDWARE INSTALLATION 

1.1  INTRODUCTION 

Congratulations on your purchase of a MotorMonitor system and thank you for 

choosing Kinder Scientific for your behavioral testing needs. Whether you've 

purchased a Cage Rack, Open Field, Rat Place Preference, Elevated Plus Maze, “T” 

Maze, Large Animal Open Field, Forced Swim, Radial Arm Maze, Zero Maze, 

Rotometer or even a custom system built to your specifications, all systems are 

designed with ample features and for years of service.  One important feature of the 

MotorMonitor software is its ability to run all our activity systems.  You have only 

one software package to learn even if you have multiple types of systems! 

1.2  MOTORMONITOR Description 

MotorMonitor has been designed to put data in your hands as quickly as possible.  

Default settings, Templates, file storage, and user definable output files have all 

been designed with flexibility and keystroke reduction in mind.  Detailed 

explanations for these features are provided later, but first let’s look at the basic 

steps of running the system. 

Basic Steps: 

1. Fill in session information screen.

2. Run the data collection session.

3. Reduce the collected data for export.

Once you have learned how to set up the system, it is really that simple. 
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The manual is divided into three chapters as follows: 

 Chapter 1 – Introduction, MotorMonitor Description, and Software &

Hardware Installation.

 Chapter 2 – Using Basic Features.

 Chapter 3 – Using Advanced Features.

We suggest that you read through Using Basic Features first and follow it up by 

running a few "dry run" sessions where you break beams with your hand.  Once you 

are familiar with the basic concepts then read Using Advanced Features to gain an 

understanding of all the features MotorMonitor provides. 

MotorMonitor records animal activity with a dedicated microprocessor and infrared 

photobeam technology.  As the subject moves it breaks photobeams on an X/Y grid.  

These beam breaks are recorded by the dedicated microprocessor located in the 

control chassis.  The collected data is then transmitted via serial communication to 

the host PC.  Additional photobeams can be used to record special "events" such as 

rearings, holepokes, lever presses or custom events.  During data collection, the 

system records the time, beam number and whether the beam was blocked or 

cleared.  The system uses post session analysis schemes, i.e., no data analyses are 

performed during runtime.  This provides the opportunity to re-analyze data with 

different parameters.  In other words, you can reset all parameters (except the 

session length) and re-analyze the original data file(s) to acquire a new view of the 

data. 

Figure 1-1 is a simplified block diagram.  Your system may have a cage rack, high 

density, open field, plus maze or forced swim enclosure, but the setup will be 

similar.  

Figure 1-1.  MotorMonitor Simplified Block Diagram 
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1.3  SOFTWARE INSTALLATION 

NOTE 

You must have administrator privileges to install the 

software. 

1.3.1  System Requirements 

 Microsoft Windows 7 Professional, or Microsoft Windows 10

Professional. (Home version not supported).

 Processor spec minimums – Dual Core 2.66GHz, 2MB L2 Cache,

1066FSB

 2 GB RAM.

 100GB Hard drive.

 At least one available serial COMM port on the PC.

 19inch  Monitor with 1280x1024 resolution.

NOTE 

- Microsoft Windows 95, 98, 2000, XP, NT, ME, and

IBM OS/2 are not supported.

- Serial to USB adapters are not supported.

- System must have screen savers and Anti-Virus

programs disabled during data collection.

- Auto updates and other software applications must not be

run during data collection.

- System power saving settings must be set to ensure there

is no interruption of hard drive during data collection.

1.3.2  Installation Preparation 

 Close all programs and turn off virus protection software to prevent

installation conflicts.
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 If you are upgrading from an earlier version of MotorMonitor, you must

uninstall the earlier version using the Remove Program feature in the

Control Panel.  Existing session files, configuration files, data files,

etc., will not be affected by uninstall, but the current build will save files

to new folders and files will use new extensions.
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1.3.3  Installation 

1. Insert the provided MotorMonitor S/W CD into the CD-ROM drive.

2. The installation uses an AUTORUN feature and will open the window shown

below:

    Software Build Number 

Click Next.  The following Window will appear: 

You must check the 

“I Agree” box before 

you can proceed. 
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Read through the License Agreement and click the “accept” box.    The following 

Window will appear: 

 For GLP installations proceed to the MotorMonitorGLP Installation Guide.  If 

you have purchased any option software such as PlayBack, HotSpots, etc, they 

will be displayed here and automatically installed.  Click Install.  The Window 

shown below will appear next when software is successfully installed. 

Click Finish to close the software 

Installation process. 
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1.4  Hardware Assembly and Installation 

The following paragraphs describe how to assemble and setup the hardware, and 

how to connect to the host PC. 

1.5  Unpacking the Hardware 

Use care when removing the hardware from its shipping container to prevent 

damage to any protruding connectors, controls, or indicators.  Although the 

components are thoroughly inspected mechanically and electrically before packing 

for shipment, they must be inspected upon receipt for damage in transit. 

1. Make sure each item on the packing list is included with the shipment.

2. Inspect all items for dents, chips and heavy scratches (gouges).  Check for

broken or bent connectors, controls, and indicators.  Photographs of damage

may be helpful in substantiating subsequent claims.  Kinder Scientific insures

all shipments for damage.

1.6  Reshipment Procedure 

If a component is to be reshipped after receipt, use of the original shipping container 

and packing materials is recommended. 

1.7  Returned Equipment with Warranty or Damage Claims 

If a component is damaged in transit or does not operate as specified when received, 

notify the carrier and Kinder Scientific customer service immediately by calling 1-

858-679-1515.  Make sure you get a Service Work Order (SWO) number prior to

returning any equipment.  Please attach a tag or form that includes the SWO

number, your company's name, address, person to contact, and telephone number.

A short description of the damage or problem will also be helpful.
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1.8  Equipment Description – MotorMonitor Systems 

The features of the MotorMonitor systems are as follows: 

 The MotorMonitor systems are high-resolution photo beam systems

equipped with onboard intelligent circuitry.

 The Behavioral System Core Control Chassis (BSC100) provides the

interface between the host computer and the MotorMonitor System.  Up

to eight Stations can be connected to the BSC100 Control Chassis.

 The power supply provides power for the BSC100 Control Chassis.

 Depending upon the type of MotorMonitor System used and options

selected, up to 40 stations can be connected to the host PC using one or

more Behavioral System Core Expansion Chassis (BSC100EXP).  This

is described in the following list.

1. The following systems can have a maximum of 32

stations connected to the host PC using one Control

Chassis and three Expansion Chassis, depending

upon included options.

 Large Open Field

 Standard 16 x16 Open Field

 Elevated Plus Maze

 Rat “T” Maze

 Forced Swim

2. The following systems can have a maximum of 40

stations connected, depending upon included options,

to the host PC using one Control Chassis and four

Expansion Chassis.

 7 x 15 High Density Cage Rack
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 Rat Place Preference

 Zero maze

 Rotometer

3. The Radial Arm system can have a maximum of 16 stations

connected to the host PC using one Control Chassis and one

Expansion Chassis.
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1.9  Control Chassis & Expansion Chassis 

As with all Kinder Scientific systems, the Behavioral System Core (BSC100), 

programmed with the MotorMonitor scanner version Control Chassis has it’s own 

separate embedded microprocessor controller.  This architecture provides a stable 

partition between the data collection effort and the host PC.  This greatly enhances 

the process of real-time data collection within the Windows 7/10 Professional 

platforms.  Communication between the Control Chassis’ embedded controller and 

the PC’s Windows platform is via an RS232 serial port.  

Each Behavioral System Core Chassis is capable of monitoring up to eight stations 

using a single PC.  This capability is increased with the addition of up to four 

Expansion Chassis.  Depending upon the configuration, a single PC can monitor 8, 

16, 24, 32 or 40 stations. In addition, should the serial connection between the 

BSC100 and the computer be interrupted during session data collection, the BSC100 

will continue to collect up to 1 hour of raw data, to be retrieved and automatically 

uploaded to the host application upon re-establishment of the serial connection. 

1.9.1  BSC100 Behavioral Core System Control Chassis  The Behavioral 

System Core (BSC100) Control Chassis is designed to work with all MotorMonitor 

Series products.  Each control chassis is capable of monitoring up to eight stations. 

An example of the Control Chassis front panel is shown in Figure 1-2. 

Figure 1-2.  Behavioral Core System Control Chassis 
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1.9.2  BSC100EXP Behavioral Core Expansion Chassis  Each 

BSC100EXP  Expansion Chassis provides the connections for an additional eight 

stations.   Each Expansion Chassis is programmed for using the Selector Switch on 

the Side of the unit as follows: 

- Switch position 1, selects stations 9 through 16.

- Switch position 2, selects stations 17 through 24.

- Switch position 3, selects stations 25 through 32.

- Switch position 4, selects stations 33 through 40.

1.10.  System Interconnection 

NOTE 

The PC you will be using must have an available serial 

port.  Preferably Comm 1, although Comm ports 1 through 

6 can be selected depending on the PC type. 

1. First, make sure all power is turned off before making any connections.

2. Connect the serial cable between the host PC to the Com Port serial

connector located on the front side of the BSC100 Control Chassis.   .

3. Connect the IEEE 1284 DB25 I/O cable from the Control Chassis to each of

the MotorMonitor system stations 1 through 8, starting with Control Chassis

connector number 1.

NOTE: (Refer to appropriate MotorMonitor Manual Addendum for

your System Application, eg. Open Field, Cage Rack, Plus Maze etc.)
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4. If you are connecting additional frames using the Expansion Chassis, make

sure the ENABLE OUT cable from the BSC100 Control Chassis is connected

to ENABLE IN on the Expansion Chassis and the SIGNAL OUT cable from

the Control Chassis is connected to SIGNAL IN on the Expansion Chassis

using an IEEE 1284 DB25 I/O cable for each.  Make sure you follow this

same convention if you are connecting additional Expansion Chassis.

5. Once all of the cable connections have been made connect the power supply

to the Control Chassis Power DIN connector located on the rear of the unit

and to the power source.  If additional Expansion Chassis are installed, each

Expansion Chassis will have its own power supply also connected to the

Power DIN connector.  Make sure these power supplies are connected and

plugged into the power source as well.

6. Turn on the computer and all the power supplies (each power supply has its

own on/off switch).

1.11  Setting the Comm Port 

You must select a Comm port in order for the MotorMonitor software to 

communicate with the hardware you just installed.  You can select from Comm 1 to 

Comm 6 depending on your PC.  Setting the Comm port is accomplished as follows: 

1. Turn on the PC and open the MotorMonitor program.  A screen similar to the

one shown in Figure 1-3 will appear.
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Figure 1-3.  MotorMonitor Start Up Screen 

2. Select the Setup pull-down menu.  Click on Concentrator Link.  Select a

Comm Port and Click OK.  This is shown in Figure 1-4.

First, select Concentrator Link 
from the Setup menu.
Next, highlight selected Comm 
port and click on Select.
Lastly, click on OK.

Figure 1-4.  Selecting the Comm Port 
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CHAPTER 2 
USING BASIC FEATURES 

2.1  Understanding Session Data Files 

The end goal is to collect activity data on each subject and place those data into 

Session Data files.  Session Data files contain user information such as the 

operator's name, animal number, sex, including a variety of user-entered 

information. 

A session cannot be run until a unique Session Data file is created for that session. 

Session Templates, Configuration files, Saved Session files, user information, and 

the collected data are used when creating a Session Data file.  These files are 

discussed in detail in Chapter 3, Using Advanced Features. 

A unique Session Data file is created each time a session is run and all data are 

stored in a proprietary format where the data is not readable by the user (i.e., raw 

data). 

It is this Session Data file (raw data plus the default template) that is used when 

performing a file reduction.  The results of a file reduction are user-readable, 

analyzed data presented in a spreadsheet or statistical format.  How to perform a file 

reduction is discussed later in this chapter. 

The default location for Session Data files is: C:\Kinder Scientific 

Data\MotorMonitor\Files.  You can use this location until you are familiar with 

all the workings of MotorMonitor. 
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2.1.1  Running a Session  To run a session perform the following steps. 

1. Turn on the PC and open the MotorMonitor program.  A screen similar to the

one shown in Figure 2-1 will appear.

Figure 2-1.  MotorMonitor Start Up Screen 

2. Select New (the white sheet on the tool bar), and then, Session.  A screen

similar to the one shown in Figure 2-2 will appear.
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8. 

3. 

4. 

5. 

6. 

7. 

Figure 2-2.  Session Screen - General Tab 

3. For Duration:  Enter the total amount of time for the session.

4. For Pre Pause: Enter the time you desire to run before the pause period.

(This feature is normally used when test subject requires dosing with two

drugs for one session.   Example - The test subject is dosed with a substance at

the beginning of a 60 minute session.  You have selected a 30 minute pre-

pause time.  The session pauses at 30 minute point, you remove subject for

dosing with a counteracting substance, place the subject back in the enclosure,

press the start switch and the session continues to run for an additional 30

minutes).  Session will run continuously after start if pre-pause time is set to 0

minutes. The Pre Pause feature requires that the Enclosure Start Method be set

to “Start Button Only”. (Refer to figure 2-3).

5. For Description:  Enter the session description.

6. For Operator:  Enter the name of the person running the session.

NOTE 



MotorMonitor User’s Manual  Chapter 2 Using Basic Features 

2-4 Version 7.01 

If you are running the GLP configuration of 

MotorMonitor, the operator’s name is entered 

automatically. 

7. For Information for a Session, Enter the session label information.

8. Select the Enclosure tab.  A screen similar to the one shown in Figure 2-3

will appear.

12. 

9. 

10. 

9a. 

11. 

Figure 2-3 .  Session Screen - Enclosure Tab 
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9. and 9a. Click on each enclosure to be used in the session. Use the Set all and

clear all buttons to aid in your selection.

10. For Information Per Enclosure enter animal specific information. (see

section 3.2.5 for importing subject information).

NOTE 

Two parameters must have entries before running a 

session.  These are Duration (step 3), and Enclosure 

selection (step 8).  There must be an entry made for 

session duration, and at least one enclosure must be 

selected before a session can be run.  If either parameter is 

blank, a session cannot be started. 

11. Select the desired Start Method:

 Start Switch, use start switch for each station after loading

test subject.

 Enclosure XY activity, starts session as soon as beam

breaks are detected.

 All Enclosures at Session begin, session starts as soon as

diagnostics finish successfully.

 All Enclosures from Enclosure 1 when Script running.

(Only used when Optional Scripts version of

MotorMonitor Software is purchased).  This feature allows

starting all enclosures with the Enclosure one start switch

at the same time.

12. If you want to save this session for running later, select the File menu, then

select Save As.  A screen will appear as shown in Figure 2-4.
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NOTE 

A Saved Session file is a complete session file with the 

exception of the collected data.  These files can be used for 

new sessions when some or all of the information remains 

constant. 

Figure 2-4.  Naming a Saved Session File 

13. Click on the yellow chevrons located on the tool bar (Figure 2-3).  A screen

will appear as shown in Figure 2-5 asking you to enter a file name for the raw

data file.

Figure 2-5.  Naming the Raw Data File 

14. Enter the desired file name and then click on Save.  You will be prompted as

shown in Figure 2-6 to start the session.  Click on Yes. 
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Figure 2-6.  Start Session Diagnostics 

15. Next, a diagnostic is performed (Figure 2-7) before running the session.

Make sure there is nothing located inside the frame that can block any beams.

If this happens, the diagnostic will fail.  You will have to remove whatever was

causing the failure and then return to step 11.

Figure 2-7.  Diagnostic Running Screen 

16. If you are running a GLP version you will need to enter your password as a

confirmation of an electronic signature.  The screen below will appear.
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17. Next, the upper level runtime screen (Figure 2-8) will appear on the display.

The upper level runtime screen provides the status for each enclosure.  One

enclosure was used in this example.

Figure 2-8.  Upper-Level Runtime Screen 

NOTE 

The number of enclosures appearing on the Upper-Level 

Runtime Screen depends upon the maximum number of 

enclosures allowed for the selected configuration.  For 

example, the 16 x 16 Open-Field system can have a 

maximum of 32 enclosures, the Cage Rack system can 

have a maximum of 40 enclosures, the PlusMaze system 

can have a maximum of 32 enclosures, and the Forced 

Swim system can have a maximum of 32 enclosures. 

(Refer to Section 1, para 1.8). 
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18. Refer to Figure 2-8 and double-click on the white backlit field.  The

lower-level runtime screen will appear similar to the one shown in Figure 2-

9. You can modify the appearance of this display from the selections on the

View menu by selecting Show Grid and/or Show XY-Sw.  Centroid,

Points and Oval are used to modify the appearance of the circle that

represents the test subject.  Take some time and activate each of these during

a session to see how each one changes the display.  These tools do not change

the data in any way; they simply provide alternate views of the subject’s

movements during runtime.  The tan dot in the lower left represents the

animals' current centroid, i.e., the calculated center of the animal based on all

beams broken.  The green squares represent each x and y beam currently

blocked.

Figure 2-9.  Lower-Level Runtime Screen 
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19. Place the animals in the enclosure and press the start button located on

the front of the enclosure.  Each enclosure will collect data independently and

will display a Done message when completed.  This allows you to inject

animals and start enclosures independently.  Once all enclosures display

Done, close the session by clicking File and Close.  If you close (abort) the

session before all enclosures display Done, the data file will contain all beam

information up to the point the session was aborted.  We cannot guarantee

capture of information of aborted session because there is a possibility that if

an abort occurs exactly when the system is writing to the file some or all data

may be lost or corrupted.

20. For Sessions that have a Pre Pause time selected you will see the

following screen when the session is paused (See Figure 2-10).  This screen

only appears if a Pre-pause time was selected when session was created.  (See

section 2.1.1 para. 4)

Figure 2-10.  Paused Runtime Screen 
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21. The session example used the 7 x 15 High Density Cage Rack frame.  If

you have a different system, the program operates the same way, but displays

your system configuration.  Primarily there will be a different number of

displayed beams.  For example, Open Field and Plus Maze systems have 16

x16 beams and any possible number of event beams (such as rearing, edge

pokes for plus mazes, etc.).  For low-density cage-rack systems there are 4 x 8

or beams.

2.2  Understanding Data Reduction or what to do with the 

collected data 

Once a session is finished, you will need to see the results of the collected data.  

This is accomplished by funneling any variety of data files into one reduction file. 

The resulting reduction file will then contain all the requested measures.  It is a 

comma-delimited file specifically set up for easy export into spreadsheets or 

statistical programs such as Excel. 

Our export files use Standard Data File formats, i.e., an ASCII file type accepted by 

the most popular programs.  There are four basic steps to data reduction. 

1. Select Desired Measures

2. Select the Files for Reduction

3. Set Interval and other analysis parameters

4. Name the Output File.
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2.2.1  Reducing Data  To reduce a data file perform the following steps. 

NOTE 

You must select at least one zone to receive any zone 

metrics 

1. Select New, then Reduce.  The display will appear similar to the one shown

in Figure 2-11.

Figure 2-11.  File Reduction “Reduce Fields” Screen 

2. Check all boxes except Immobility. Immobility is only used with the Forced

Swim Option.  Although not required for a reduction, we recommend the

Column Heading box is checked.  This parameter causes the first line of

the output file to show the title of each of the output columns.  Note about

output File type, Coordinate Event outputs raw event files, and are not

applicable to GLP Studies.

3. Select Next.  The display will appear similar to the one shown in Figure 2-

12.
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Figure 2-12.  File Reduction “Reduce Files” Screen 

Location of the raw data 
files

Raw data files

Used for moving 

single files back 

and forth. 

Used for moving 

all the files back 

and forth. 

Location of the reduced data 
filesField for user-entered 

file name with the  .csv
extension

Used to change the 

default reduction 

parameters (see table). 

Takes you back to the
previous page

Starts the file reduction
process.

Parameter Purpose

X Y Smoothing Window

Rest Time Threshold Establishes what "at rest" means

Fine Count Holdoff Sets max rate counter can increment

Debounce* Helps eliminate electrical noise

Interval 

Immobility* 

Time slice for a session 

Eslablishes what level of movement 
during selected time is Immobile.

Distance correction

*Normally set to off (not checked) – See 
**Immobility -  used only for Rat Forced  

Using Advanced Features 
Swim Testing.

Default Reduction 
Parameters

File selection list. 

Used for selecting a file 

or files for reduction.

**Immobility Filter and 
Measure are used only 
with Forced Swim Option 
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4. Select the file or files you want to include in the reduction.  To select a file,

either double-click on each file to move it to the selection list or click once on

each file to highlight it, and then click the single right chevron.  The double

chevrons move all files to and from the selection list.  You can select as many

as you like with one word of caution, it's a good idea to select only files with

the same session length.

NOTE 

If files of different session lengths are used you will 

receive complaints from the software. 

5. Next, set the Interval you want to use.  This parameter determines the width

of the time slice you want the data divided into.  For example, you might

have a one-hour test you want divided into 10-minute data intervals.  Set the

interval to 10 minutes and zero seconds.

6. Enter the file name in the Reduced Data Filename Base field making

sure you add .csv as the file extension.  Although optional, this can be

particularly helpful if you are using a program such as Excel.

7. Click on Begin.  The system creates an output file and places it in the

Reduced directory.

8. Click File then Close and you will return to the main Window. You are now

able to import that file into your spreadsheet or statistical program.

9. Open Excel and then open the file you just saved.  The data will appear

similar to Figure 2-13.
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Figure 2-13.  Excel Reduced Data File Example 

NOTE 

The example shown in Figure 2-13 is the result of a 

validation session using the EM100 Photo Beam 

Validation System. 

Document Encl Interval Parameters Date Time Session Info 1

SampleSession1 1 1 NI010200100000150100005 20060803 155259 User info space

SampleSession1 1 2 NI010200100000150100005 20060803 155314 User info space

SampleSession1 1 3 NI010200100000150100005 20060803 155329 User info space

SampleSession1 1 4 NI010200100000150100005 20060803 155344 User info space

Session Info 2 Session Info 3 Session Info 4 Animal # Group/Sex Dose Level Session Info 5

for up to four separate fields 123456 StudyA/male 1mg/kg for up to four

for up to four separate fields 123456 StudyA/male 1mg/kg for up to four

for up to four separate fields 123456 StudyA/male 1mg/kg for up to four

for up to four separate fields 123456 StudyA/male 1mg/kg for up to four

Session Info 6 X Ambulation(KSE) Y Ambulation(KSE) Periphery<Distance(in)>

separate 61 80 153

separate 33 28 64

separate 0 0 0

separate 1 0 3

Periphery<TotTime(sec)> Periphery<RestTime(sec)> Periphery<Entries> Periphery<PokesInto>

15 0 0 0

15 9.8 0 0

15 15 0 0

15 15 0 0

Center<Distance(in)> Center<TotTime(sec)> Center<RestTime(sec)> Center<Entries> Center<PokesInto>

0 0 0 0 0

0 0 0 0 0

0 0 0 0 0

0 0 0 0 0
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The headings and data provided by the reduced data file readouts are fairly 

straightforward with the possible exception of the Parameters column.  This 

information reflects the settings of the Default Reduction Parameters screen.  

These settings also appear on the second page of the Reduce Data Files screen 

(except Distance Units) and can be modified for an individual file reduction 

session.  The Default Reduction Parameters screen can be accessed by 

selecting the Setup pull-down menu and then selecting Default Reduction.  An 

example of this screen and a description of what the Parameters heading means 

are described in Figure 2-14.  Also, you can exclude the Parameters column from 

the Reduced Data file readout by un-checking the box labeled Include 
Parameters Column.   Immobility and Auto Reduce settings are included the 

column.   

Figure 2-14.  Default Reduction Parameters Description 

 Debounce: N=Not Selected, D= Debounce selected.

 Distance Units: I = Inches, C= Centimeters.

NC010200100000150100005
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 XY Smoothing Window: 01 = 0.1 Seconds.

 Rest Time Threshold: 020 = 2.0 Seconds.

 Fine Count Holdoff: 010=01.0 Seconds.

 Interval: 000015 = 0000 Minutes, 15 Seconds.

 Immobility: 0100005 = 0005 beam breaks or less per 01.0 Seconds.

NOTE: Forced Start at Scan feature enables the option of allowing the reduction of 

data at a predetermined number of beam breaks, only used if an enclosure did not 

have the start switch pressed accidentally at the beginning of the session.  Normally 

would not be used.  

2.2.1.1  Ambulation Type  The other parameter on the Default Reduction 

Parameters screen is Ambulation Type.  When HK Enhanced is selected, the 

software becomes much more discriminatory when dealing with the difference 

between ambulation and fine movement.  The definitions of these two movement 

metrics can be found in the glossary, but are repeated here as part of this description. 

Ambulation 

A measure used to express larger animal movements, i.e., the subject changed 

its entire body position on the grid.  A brief description of the algorithm 

follows: an ambulation occurs when a new beam block occurs and the anchor 

beam for that dimension is released (cleared) before the new beam.  The anchor 

beam is the lowest beam blocked in that dimension.  For example, if X2, X3 & 

X4 are blocked and then X5 is blocked, the new beam break at X5 will be 

counted as an ambulation if X2 is cleared first.  Otherwise, the break at X5 is 

recorded as a fine movement.  By definition, the animal must relocate its whole 
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body to cause an ambulation count.  X and Y ambulations are reported 

separately. 

Fine Movement 

A measure used to express smaller animal movements, i.e., the subject changes 

a beam status but the change does not fit the definition of an ambulation.  One 

example would be a single beam changing status while no other beams 

changed status.  There are more complex Fine Movements such as head 

weaves.  For example, if an animal is repeatedly moving its head from left to 

right and back again; it could alternately break beams on the left and right sides 

of its head.  Fine Movements are used to report movements such as grooming 

and/or head movements.  The Fine Movement counter is incremented because 

of the Beam status change not meeting the Ambulation algorithm.  That is, 

there is no specific test for Fine Movements. 

While the previous statement is still true, the Ambulation algorithm is now 

capable of making a more informed decision as to what is and what is not an 

ambulation.  An example of this is provided using the EM100 Photo Beam 

Validation System.  The EM100 creates Ambulations using an activity vehicle 

moving in a predetermined path.  Fine Movements are created using a stationary 

beam interrupter.  The EM100 is designed so that these two movement metrics 

cannot occur simultaneously. 
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Figure 2-15 shows movement metrics from the same data file.  A file reduction 

was performed with Standard as the selected Ambulation Type and then 

repeated with KS Enhanced selected.  Note that in the first, third, and fifth 

intervals of the Standard reduction that even though the activity vehicle was 

providing all of the beam breaks, about one-third of the beam breaks were defined 

as fine movements.  With KS Enhanced selected for the file reduction, the data 

is much more accurate. 

Figure 2-15. Ambulation Type Selection Examples 
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2.2.2.   Understanding Reduced Files and Zone Maps  There are two   

measurement types available for data reduction.  These are Movement Metrics 

and Zone Metrics.  Zone metrics are the result of an optional zone map included 

with the collected data.  A zone map is not required for data reduction and, if not 

included the Zone Metrics fields will not appear on the screen.  This is shown in 

Figure 2-16. 

Figure 2-16.  Reduce Fields Screen With and Without a Selected Zone Map 

During data reduction, zone metrics are included in the reduced output file 

according to the zones defined in the active zone map.  Distance, Total Time, 

Rest Time, Entries, and Pokes Into zones are all calculated per zone/per interval. 

You must select at least one zone in the Zones to Include field for any zone 

metrics to appear in the output file. 
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Typically, zone maps are created by the user to fit a specific test.  When 

MotorMonitor was installed, a sample zone map was included as the default and 

will be used for data reduction until another one is created.  The sample zone map is 

provided for reference only and may or may not provide any meaningful data. 

You can view the current zone map by clicking on File, Open, and then Zone 

Map.  A selection screen similar to Figure 2-17 will appear. 

Figure 2-17.  Zone Map Selection Screen 

MotorMonitor will display a selection window containing only the factory sample 

map until you create more of your own.  To create or modify zone maps see Using 

Advanced Features. 

Figure 2-18 is the zone map used for the data reduction example shown in Figure 2-

13. 

NOTE 

All of the functions in this chapter are described in detail 

in Chapter 3, Using Advanced Features. 
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Figure 2-18.  Sample Zone Map 
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CHAPTER 3 
USING ADVANCED FEATURES 

3.1  Introduction 

This chapter is broken into four parts.  General Setup Issues describes 

MotorMonitor's file handler, how to setup file locations, how to setup Default 

settings, and how to take advantage of the keystroke reduction features.  The next 

part, Advanced Data Reduction Techniques, describes the types of measures 

available and how to take advantage of them.  The third part, System Diagnostics, 

provides some insight into how advanced diagnostics work and how they can help 

you troubleshoot your system in case of a problem.  The fourth part, Printing 

Session Information, describes how to print session setup information. 

3.2  General Setup Issues 

3.2.1  Using MotorMonitor's File Handler  A special approach has been used 

to simplify the user's efforts when handling MotorMonitor files.  The approach 

centers on file extensions.  Table 3-1 lists all file types and their file extensions. 

Table 3-1.  MotorMonitor File Types and File Extensions 

File Type Extension Description 
Session   ._ksmmdat The Raw data file from a session. 

Saved Session   ._ksmmses A session file saved for later use. 

Session 
Template 

  ._ksmmstm A file used to pre-fill the session 
input screen. 

Zone Map   ._ksmmzmp A file used during data reduction to 
partition data. 

Configuration   ._ksmmcfg A file created by the factory to 
configure hardware (typically cannot 
be changed by user). 

Important: Older versions of application software used a different file extension 

structure, specifically “._hkmmdat, ._hkmmses, ._hkmmstm, ._hkmmzmp, and 

._hkmmcfg”. For using older files created using these extensions on the software 

build versions applicable to this manual, simply rename the file using the extensions 

listed in table 3.1, above. (e.g. , 123456._hkmmdat renamed to 123456._ksmmdat) 
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MotorMonitor displays only the files related to the selected function.  For example, 

if you are loading a different zone map for data analysis only the files with the 

extension ._ksmmzmp will be displayed.  However, only the file names (without 

the extension) are displayed.  The file names will only be zone map files.  This 

approach removes the clutter of unrelated files for each task, i.e., only the selected 

file-types are displayed even though other files (of other file types) may exist in the 

same folder. 

3.2.2  Browse Buttons  While stepping through the various MotorMonitor 

screens you will encounter a small button with three dots inside.  This button is used 

to represent the browse button.  Simply click on the button and you will invoke a 

Windows-type browse feature. 

3.2.3  Setting Default Files/Folders  You can customize your system by 

configuring the default settings to your specific needs.  To set the defaults click on 

Setup, then click on Default Files/Folder.  A menu will appear as shown in 

Figure 3-1. 

Figure 3-1.  Setup Default Files/Folders Menu 

Select  Default Files/Folder 

from the  Setup  menu and 

the following screen will 

appear on the display 

Browse 

buttons 
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3.2.3.1  Folder Tab - Default Application Folder  This field determines where 

MotorMonitor stores the raw data files (refer to Figure 3-1).  You can use this 

setting to store each study in a different directory.  However, if you change the 

directory for each study, you must change this default each time you start a new 

study.  To change the directory, click on the browse button at the end of the field.  

This is how the browse button appears (most of the time) throughout MotorMonitor. 

3.2.3.2  Folder Tab - Optional Auxiliary Data Storage Folder  This is a Part 

11 and data security feature.  This feature provides a redundant raw data file to be 

stored automatically at the end of each session.  It is most commonly used as a way 

to provide a copy of the raw data to a network.  Simply provide the path where you 

want the extra file to be stored.  If this default is left empty, the system will only 

store on the local drive.  If the secondary drive is not available or has a failure 

during a session, this feature will not prevent the collection of the data for a session.  

Instead, it will provide a message indicating the secondary site was not available and 

then it’s up to the user to make the file manually available when the secondary drive 

is functioning. 

3.2.3.3  Folder Tab – Delimited Output Files  This field determines where 

MotorMonitor will store the reduced data files (refer to Figure 3-1). 

3.2.3.4  Encl Config Tab - Default Configuration File  This file is normally 

set when your system is installed and never changed (Figure 3-2).  The only reason 

to change this default is if you purchase an option later that would require a change 

to the configuration file or if you are running two different activity systems on the 

same computer.  Please contact the factory before changing anything in this file. 

CAUTION 

Altering the Configuration file can cause the system to 

malfunction. 
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Figure 3-2.  Encl Config Tab 

3.2.3.5  Ses Temp Tab - Default Session Template File  The Session 

Template file is the first thing that appears on the display when you start a new 

session.  Basically, the file contains common parameter settings and user 

information fields that are set automatically when you start a new session.  This file 

is used as a basic fill in the blank routine for those items that you may commonly set 

with one value (for at least one study).  You can change this setting each time you 

want a different template to automatically load its values into new session headers.  

Session Template files are described in detail in paragraph 3.3.4 of this chapter. 

Figure 3-3.  Ses Temp Tab 
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3.2.3.6  Zone Map Tab - Default Zone Map File  This field is repeated on the 

first data reduction screen.  You can change this file each time you want a different 

zone map for use during post processing.  Setting the default zone map only pre-fills 

the field on the first reduction screen to this selection.  It does not force this file as 

the only choice.  You may change the zone map during data reduction by clicking 

the browse button on the reduction screen and changing it to a different one. 

Figure 3-4.  Zone Map Tab 

3.2.4  Setting Default Reduction Parameters  To access the Default 

Reduction Parameters screen click on Setup and then Default Reduction.  This 

is shown in Figure 3-5.  These fields (except Distance Units) are repeated on the 

second data reduction screen.  Entering values into these fields from this screen pre-

fills the fields on the second data reduction screen (another keystroke reduction 

feature).  You can change these settings from the second data reduction screen on a 

case-by-case manner.  It is important to remember that the software “remembers” 

the settings used in the most recent reduction effort and uses those settings on the 

subsequent reduction effort.  This allows the user to “set” parameters and use them 

on all subsequent reduction efforts without the need of re-typing those parameters.  
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Figure 3-5.  Default Reduction Parameters Screen 

As a starting reference, set the XY Smoothing Window to 0.1 second, Rest 

Time Threshold to 2.0 seconds and Fine Count Holdoff to 00.0.  Fine count 

holdoff is used for animals with extremely high amounts of small movements such 

as non-ambulatory stereotypic movements. The KS Enhanced Ambulation Type is 

recommended as it contains an improvement to the ambulation algorithm.  The 

Immobility filters are not relevant to systems except Forced Swim stations.  We 

suggest you have the Debounce filter not checked. The Debounce filter forces all 

beam breaks of less than 100 milliseconds to be ignored.   

Auto Reduce option is specifically designed to help GLP labs reduce keystroke 

entry errors.  When this box is checked, the software will automatically reduce the 

current session using the same base filename as the raw data file.  The reduction will 

be based on the current (last used settings) parameters. The reduced file will be 

placed in the path set in the Default Files Folder for Delimited Output Files.  Forced 

scan at start is only used if the start switch was not pressed at beginning of session 

to allow emergency data reduction. 

Select  Default Reduction 

from the  Setup  menu and 

the following screen will 

appear on the display. 
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3.2.5 Importing Subject Information  There are three text fields which can 

be used to store important information for each subject.  These fields can 

be either be manually typed in, as described in section 2.1.1, or the user 

may import one or more of the three columns of data from an existing text 

file.  When you either open a new Session or create a new Session, you 

can enter animal information by clicking on the Enclosure tab.  A screen 

similar to the one below will appear.  

Manual entries can be made for each subject on 

this screen. 

Alternatively, you may choose to Import Subjects information.  Consider 

the following example: 

Click on Setup the Import Subjects to import 

information from a text file.   



MotorMonitor User’s Manual  Chapter 3 Using Advanced Features 

3-8 Version 7.01 

A screen similar to the one below will appear. 

Optional Heading Overwrite 

The file ImportSample1.csv is an ASCII comma delimited file containing the 

following information: 

Subject,Dose,Sex 

1A111,1mg/kg,m 

1A112,control,m 

1A113,1mg/kg,f 

1A114,control,f 

1A115,2mg/kg,m 

1A116,2mg/kg,f 

1A117,3mg/kg,m 

1A118,3mg/kg,f 

By clicking on a particular file the software will automatically import the subject 

information from that file into the appropriate fields in the session Enclosure screen. 

In our example the Session Enclosure window will appear as shown below: 
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 In our example we also were able to change the 

name of the column headings by having the first 

row of the import file include the desired names 

and also telling the software by clicking the box 

for Has Heading.  
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3.3  ADVANCED DATA REDUCTION TECHNIQUES 

3.3.1  Controlling the Output File  The first of the two screens used in data 

reduction determines all measurement variables (Movement Metrics, Zone 

Metrics, Zones to Include, etc.) to be included with a reduced session file 

(Figure 3-6).  The second screen (Figure 3-7) determines which file or files to 

reduce and where they are to be stored. 

Figure 3-6.  File Reduction “Reduced Fields” Screen 

Please refer to the Glossary for definitions for all measures. 

1. The Enclosure Number and Interval Number are always included in the

output file.

2. Check these boxes to include the Date, Time of Day, and Session Info

fields in the output file.

1 

2 

3 

4 

5 

6 

7 

8 

10 

9 
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3. Check Enclosure Info to include the three individual (or less depending on

the template setup) information fields.
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4. Movement Metrics  Check Fine Movements and/or X/Y Ambulations.

While MotorMonitor contains a set of very advanced features, it is still

sometimes useful to report simple beam breaks.  To export a total of simple

beam breaks, select fine movements only.  Do not select any other measures.

5. Zone Metrics  Check which of the zone metrics you want.

6. Zones to Include  Choose which zones to be analyzed and included in the

output file.

7. Separate Files By  You can have a single file reduction (None), one file

for each session (Session) or a file for every enclosure (Ses/Encl).

8. Use Zone Map:  Select which zone map you want used for analysis.  You

can also create a different zone map and re-run the data reduction routine

using the same data files.  Remember, choosing a different zone map changes

the current reduction effort.  The results for the  Zone Metrics and Zones

to Include fields are calculated using the selected zone map as a reference.

NOTE 

If the USE ZONE MAP field is empty (cleared), the 

Zone Metrics and Zones to Include fields will not 

appear on the Field Selection List. 

9. You need to tell the system which template to use during data reduction for

heading information.  You can also select an original data file for this

function.  To do this, click on Browse, then click the down arrow on Files of

Type then select Within a Data File.  Select from the list provided.

10. If this field is empty, use the Browse button to locate and select the proper

configuration file.
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3.3.2  Selecting Files for Reduction  You can select any number of files for 

reduction and have the resulting data placed into a single file.  To do this click on 

the desired files one at a time until you have all desired files highlighted and then 

click the right chevron.  This will add the selected files to the Files to Reduce list. 

The files that were selected in this example are shown in Figure 3-7, in the Files to 

Reduce list.  Another way to create the list is double click each file.  Each double 

click automatically moves that file to the Files to Reduce list.  If you make a 

mistake and move a file that you actually do not want on the list, simply click on the 

file in the list and then click the left chevron.  The two double chevrons move all 

files back and fourth.  These features are described in Figure 3-7 and the references 

that follow. 

Figure 3-7.  File Reduction “Reduced Files” Screen 

1 

2 
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10 
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11 
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1. Look in Folder:  This is where the source files for reduction come from.

If you have created multiple folders for file management purposes you will

need to tell the software where to look for the data files you want to reduce.

To do this click on the browse button at the end of the Look in Folder field

and select the appropriate path.

2. Left/Right Single Chevrons.  Used to move single or selected files back

and forth.

3. Left/Right Double Chevrons.  Used to move all the files back and forth.

4. Reduced File(s) to this Folder:  This is the output file destination.  You

can direct the output file to any folder or drive you desire, including network

drives.  The easiest way to do this is to use the browse button and select the

desired folder.  This is because the path must be exact.

5. XY Smoothing Window:  This parameter corrects for errors in distance

caused by system data collection speed.  Since data is collected every 50

milliseconds, it appears that the animal does not travel in straight diagonals,

i.e., the path will always fall on the grid lines of the photobeams.  This is

because the odds that the animal broke both dimensions on the same data

collection sample are extremely low.  Therefore, setting this parameter will

correct this error.  We suggest you begin with 0.1 seconds.  Because plus

maze systems do not allow diagonal travel by design, and this parameter will

not offer anything meaningful for that system.

6. Rest Time Threshold:  There are three time related measures that provide

great insight into an animal’s behavior.  These are rest time, active time and

total time in zone.  While there is not a direct output of active time, it is

simply the difference between the Rest Time and Total Time.  The question

is, what does "at rest" mean?  Alternatively, how long does an animal sit still

to consider them “at rest.”  If you set it to 2 seconds then an animal must not

move it's centroid for 2 full seconds before any time is added to the rest-time

counter.  Everything, including the 2 seconds, will also be added to the

counter until the centroid position changes.  Remember, this measure is

based on the centroid, not simple beam breaks.  Accordingly, the animal

could break the same beam repeatedly and still be considered "at rest."
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7. Fine Count Holdoff:  As described in the glossary, any beam break that is

not an Ambulation is a Fine Movement.  The point of these two measures is

to differentiate a beam break that results from the animal relocating it's

entire body and ones such as grooming, head weaves, tail flicks, etc.

Sometimes it can be useful to filter the Fine Movements to ignore high

frequency counts caused by activities such as scratching.  If you want every

beam break to register, make sure you set this to zero.

8. Debounce.  This is somewhat of an artifact from the developing years of

motor activity.  When set on it simply ignores any beam break that is not at

least 101 milliseconds long.  We suggest that unless you have a particular

reason to use this you should leave it off.

9. Interval.  This parameter determines the length of the time slice you want

used for data reduction.  For example, if you have a one-hour test and you

want to slice the data into 12 equal parts you would set this parameter to 5

minutes.  One word of caution, this parameter must divide evenly into the

total test time.  If you set the interval to something not evenly divisible into

the total time, the remaining data will be truncated, i.e., it will not be placed

in the output file.

10. Reduced Data Filename Base:  This is where you give the reduced file

a name.  Remember to add the .csv extension to the file name.  You can

send the output file to any drive and folder location your computer has access

to, including network drives.

11. Immobility: This filter and its related measure are only used for the Forced

Swim option and generally used for rats, not mice.  The filter is used to

ignore all beam breaks the subject uses during treading.  Since mice can float

and generally do not tread the filter and measure are not intended for mice.

At good starting point for the filter is 5 breaks in 1 second.
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3.3.3  Creating a New Zone Map  To create a new zone map, click on New, 

then Zone Map from the File menu.  Next, you will be asked if you want the map 

to be based on the current configuration (Figure 3-8).  If you have only one 

configuration, or if the correct configuration is active, then click on Yes.  The 

question is asked because there can be more than one configuration type.  For 

example, you might have both a cage rack and a plus maze system on one computer. 

Figure 3-8.  Starting a New Zone Map 

Current configuration is: 16 x 16

Current configuration is: 7 x 15

Current configuration is: 4 x 8

Select Yes and

You'll get one of

these.

Select No and

You'll get this.
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To use Select Area, click on Edit and then Select Area.  Place the mouse in the 

upper left of the desired area and while holding down on the left mouse button drag 

the mouse to the lower right and release the mouse button.  This selects all blocks.  

After releasing the mouse button, the entire set of blocks will be highlighted with 

gray outlines.  This indicates the software is waiting for you to assign a zone color 

to those blocks. 

Using Select Each works in a similar manner except it selects one block at a time. 

To use Select Each, click on Edit and then Select Each.  Place the mouse in the  

Figure 3-9.  Elevated Plus Maze System Zone Map Example 

desired block and left-click.  The selected block will be highlighted with a gray 

outline.  This indicates the software is waiting for you to assign a zone color to the 

selected block. 

In a zone map, each color represents a zone, even if the blocks are not contiguous. 

For example, the zone map in Figure 3-9 was created for the Elevated Plus Maze 

system.  Even though all but one zone is non-contiguous, MotorMonitor treats each 

color as one zone.  However, until colors are assigned to the zones, the map is 

meaningless. 
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Assigning all blocks to a zone is not required.  If a block is not assigned to a zone, 

there will be no data available for those blocks. 

Use these tools to create a zone map.  Figure 3-10 shows you how to do this. 



MotorMonitor User’s Manual  Chapter 3 Using Advanced Features 

Version 7.01 3-19

Figure 3-10.  Creating a New Zone Map 

For Select Each, select individual

square(s), then click on the desired

zone.

Select Each Select Area

For Select Area, left-click and drag

mouse pointer over the desired

area, then click on the desired

zone.

1. To modify a zone label,right-click

on the desired zone and the

Zone: field will appear.

2. Enter a new Zone Label here.

3. To modify a zone color,click here

to invoke the Color  menu.

4. Select a color from the Color  menu, click OK,

then click OK on the Zone: field.  The

modified zone will now reflect the changes.

Modifying Zone Labels and Colors
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3.3.4  Session Template Files  If no default session template is selected, the 

first thing that appears on the display when a new session is selected is the session 

screen with blank information fields.  A session template file consists of a session 

screen pre-filled with specific session information and then saved as a session 

template file.  The primary purpose of a Session Template is naming the column 

headings for the output files.  The secondary purpose is keystroke reduction. 

Keystroke reduction minimizes redundant data entry therefore limiting the incidence 

of entry errors and wasted data entry time.  A Template file helps you: 

1. Pre-fill the Description Field

2. Choose the number of Session Information Fields (up to four).

3. Name the Session Information Field Labels

4. Pre-fill Session Fields (optional)

5. Set Session Duration

6. Choose enclosures to be used

7. Choose the number of Enclosure (Subject) Information Fields (up to three)

8. Name the Enclosure Information Fields

The default session template file is set by accessing the Ses Temp tab of the 

Default Files/Folders menu and then selecting a session template file.  This is 

shown in Figure 3-11.  The selected default session template file will appear 

whenever a new session is started. 

NOTE 

This does not apply when opening a Saved Session.  When 

opening a Saved Session the column headings are 

determined by the Session Template File that was used 

when the Saved Session was created. 
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Figure 3-11.  Selecting the Session Template Default File 

From the Setup menu, select Default Files/Folder .

Click on the Ses Temp tab.

1

2

3

4

5

Click on the

Browse

button.

Step 3 opens the Session

Template folder.

Select a new Session

Template, then click

on Open.

When you complete step 5, the Setup Default Files/Folders  screen will re-appear and

the new Session Template file will be in the default path.

6

Select OK.7



MotorMonitor User’s Manual  Chapter 3 Using Advanced Features 

3-22 Version 7.01 

3.3.4.1  Modifying Existing Template Files  To modify an existing template 

file, click on Open, then Template from the File menu.  The session template 

folder will appear on the display.  Once a file has been modified, it can be saved 

under its existing file name or saved as a new file. 

3.3.4.2  Creating New Session Template Files  The following steps provide 

an example for creating a new Session Template. 

1. Click on New, then Template from the File menu.  A blank Session

Template similar to the one described in Figure 3-12, will appear.

Figure 3-12.  New Session Template 

These two labels only appear during

template creation/modification.
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2. Modify the display as describe in Figure 3-13.

Figure 3-13.  Modifying the General Tab on the Template Screen 

19. Click on the Enclosure tab.  A screen similar to Figure 3-14 will appear.

Modify the display as described in the figure.

Make these entries

Delete the text from

this field
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Figure 3-14.  Modifying the Enclosure Tab on the Template Screen 

4. From the File menu select Save As… then give the template a unique

name that will give you a clue to its original purpose.  For the example the

name testtemplate was selected for this example.

5. From the File menu select Close.

6. From the Setup menu select Default Files/Folders.  Click on the Ses

Temp tab, then click on the browse button.

7. Select the desired template from the Default Session Template folder.

For this example the file named testtemplate was selected.  Click on OK

to make this file the default session template file.

8. From the File menu select New, then Session.  The display will appear as

shown in Figure 3-15.  Note that the field where the text was deleted in step

2 is no longer present.

Delete the text from

this field
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Figure 3-15.  New Session Template Screen Reflecting the Default Sample 
Template 

9. Click on the Enclosure tab.  A screen similar to Figure 3-16 will appear.

Note that the field where the text was deleted in step 3 is blank and the

column is no longer present.

Figure 3-16.  New Session Screen Enclosure Tab Example 
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10. Once this example is set as the default template all new sessions will open

with this template until a new default template is selected or the default tab

is cleared (turned off).

3.3.4.3  Creating and Using Saved Session Files  A Saved Session file is a 

complete session file with the exception of collected data.  The purpose of Saved 

Session files is similar to Default Template Files.  The difference is Saved Session 

files also include the individual enclosure information (up to three fields).  These 

files can be used when running the same animals over or when some or all of the 

information fields remain constant.  To create a Saved Session file simply create a 

new session and before running the session click on File and Save As.  Then enter 

a unique file name for future use.  You can then run the Saved Session as many 

times as you like.  Just remember to do a Save As to give each session its own 

unique name when asked.  There is no "default" Saved Session file.  To use a Saved 

Session click on File, Session, and a list of all Saved Sessions will appear.  Select 

the desired saved session, then click on Open.  The Saved Session will open and 

appear as if you had just entered it.  Before you do anything else, select Save As 

and assign a new name to prevent overwriting the original.  It is now ready to run. 
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3.4  SYSTEM DIAGNOSTICS 

3.4.1 Understanding and Troubleshooting Diagnostic Failures  

MotorMonitor comes equipped with the industry's only true auto-diagnostics.  This 

automatic diagnostic runs before each session and performs extensive tests on the 

photobeam pairs and their supporting circuitry.  If the system detects a failure during 

these tests, you will not be able to proceed until the failure is resolved.  There are 

two ways to resolve a failure; you must either correct the failure or remove the 

failed enclosure from service.  If there is a diagnostic failure, a screen similar to 

Figure 3-17 will appear.  Green and red are the only colors used for diagnostics.  

Green indicates passing diagnostics and red indicates a diagnostic failure. 

Figure 3-17.  Upper Level Diagnostic Screen 
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This is the "upper" level diagnostics screen.  As you can see, it displays all possible 

enclosures for the system, even those that are not connected.  For each connected 

enclosure, five different tests are performed as follows: 

1. Full & <Full (all tests)

2. Full (full power)

3. <Full (less than full power performance)

4. >Off (Very low power)

5. Off (shorts)

If any of these tests fail, a diagnostic failure warning is generated.  You can try to 

resolve the issue by entering manual diagnostics to determine the problem.  The 

most common problem is a blocked beam, usually an animal in the enclosure.  This 

is the failure shown in Figure 3-17.  In this case, the two upper tests (Full and 

<Full) are red.  This is the normal failure indication for a blocked beam and is easily 

resolved by removing the obstacle from the enclosure and then re-starting the 

session.  If only one of these blocks is red, contact the factory. 

You can run manual diagnostics to determine the failure and restart the session.  

Once you have resolved the failure, you can restart the session by clicking on the 

double yellow chevrons again.  The system will run the auto-diagnostics again and, 

assuming the failure has been resolved, the session will be re-started. 

In addition, a “lower” level diagnostic screen provides more detail on any particular 

enclosure.  To reach this screen, place the mouse over the "test blocks" for the 

desired enclosure and double click the mouse.  A display, similar to Figure 3-18, 

will appear on the screen. 
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Figure 3-18.  Lower Level Diagnostic Screen 

The green blocks indicate that something is blocking those beams.  The corner block 

is always the start switch and when pressed will turn yellow.  The blocks to the right 

of the start switch are the X beams and are numbered from 1 to n, left to right 

respectively.  The beams located above the start switch are the Y beams and are 

numbered similarly with Y1 being located closest to the start switch.  In this case, 

the beams X1 and Y1 are blocked. 

3.4.2  Using Manual Diagnostics  While MotorMonitor automatically runs a 

very sophisticated and complete diagnostics before each session, it is still useful to 

have access to manual diagnostics.  To manually start the auto-diagnostics, click on 

the green "L" on the tool bar. 

If a diagnostic failure has occurred, the View menu on the lower level diagnostic 

screen will have each individual diagnostic test available for selection.  These are 

the same five tests described for the upper level diagnostics, with different names. 

If a single test is selected, it will run, continuously, until terminated by the operator. 

Figure 3-19 provides an illustration of the menu and a comparison chart relating the 

upper level tests with the lower level tests. 

Y-axis beams
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X-axis beams

This block represents the frame
start switch, and turns yellow
when the switch is pressed.

Green in these blocks
indicates beams X

1
 and Y

1

are being blocked.
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Figure 3-19.  Lower Level Diagnostic Screen View Menu 

Equivalent Lower Level Test

Beam Status (All Tests)

Test @ Full Power

Test @ High Power

Test @ Low Power

Test for Shorts

Upper Level Test

Full  & <Full

Full

<Full

>Off

Off
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3.5  GLP CONSIDERATIONS 

3.5.1 Printing Session Information 

Most labs require some type of audit trail containing electronic signatures and much 

more.  To help with this requirement MotorMonitor products have all related 

information stored in the raw data file.  The configuration used, information input, 

operators name and more are included in each raw data file.  While in the data 

reduction menu you can obtain a printout of an individual session as follows: 

1. Go to the second data reduction screen.

2. Select the individual session in question from the Files in Folder list.

3. Move the file into the Files to Reduce list.

4. Click on the File pull-down menu and then click on Print.

An example of a session printout is provided in Figure 3-20. 

Figure 3-20.  Session Printout Example 

3.5.2 Microsoft Windows  Requirements for MotorMonitor  

MotorMonitor was designed to run on Windows 7 Pro and Windows 10.  The 

software will not run on Windows 95 and 98 and we no longer support Windows 

NT, XP, and 2000.   However, the software should perform properly on a Windows 

NT network environment.  
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APPENDIX A 

MOTORMONITOR OPTIONS 

MM100 - HOTSPOTS GRAPHIC COMPARATOR 

MM200 - OVERTIME GRAPHIC COMPARATOR 
MM300 - PLAYBACK MODULE 

A.1  INTRODUCTION

These options increase the power of the MotorMonitor system adding different, in-

depth views of captured data, and as a standard feature with the EM100 Photo Beam 

Validation System, add an additional dimension to validation script creation. 

HotSpots is used to acquire instant, graphical comparisons of session results 

eliminating the need for making assumptions with zone maps.  This allows you to 

generate a zone map based on actual activity.  Data can be displayed from a single 

enclosure or from an enclosure ensemble allowing you to visually compare animals 

or groups. 

OverTime is for viewing changes in activity over a specified period of time.  Zone 

metrics (distance, total time, rest time entries, and pokesinto) can be charted for 

multiple zones.  You can see how an animal or ensembles of animals change as time 

changes.  This allows establishing baseline expectations as well as displaying a view 

of the changes that a drug causes over time. 

PlayBack allows you to view the path of an animal as if you are watching a video.  

This is, essentially, a graphic depiction of animal activity for an entire session. 

The examples used in this appendix were generated using the EM100 Photo Beam 

Validation System.  All the examples use the same zone map, configuration file, 

data file, template file, and reduced-file data. 
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A.2  HotSpots 

HotSpots is an activity gradient display where red represents the hottest activity area 

and blue the coldest.  Activity concentrations that fall between the two extremes 

follow the color spectrum between red and blue. 

A.2.1  Starting HotSpots

Figure A-1.  Starting HotSpots 

1.  Select HotSpots

2.  Select the Type of data

3.  Select a data file

4.  You end up here
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The next thing is to select OK from the HotSpots Setup Screen.  Figure A-2 is 

the resulting display based on the selected file and the settings from the HotSpots 

Setup screen in Figure A-1. 

Figure A-2.  Initial HotSpots Display 

There are several ways to view the data.  Figure A-3 provides examples of each of 

the View menu selections. 
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Figure A-3.  HotSpots View Menu Examples 

Show Spot Border example

Show Legend example Boxes Fine example.  Note that

the selection now reads:

Boxes Normal

The border lines represent the

left and right edges of the

photobeams

Show Grid example

The grid lines represent the

center of the photobeams
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Figure A-4 shows examples of each of the Intensity selections from the Setup 

screen.  HotSpots normalizes all activity data to “1” in time and position where 

“1”(red) represents maximum activity and “0” (blue) represents no activity.  The Sq 

Rt (square root) and Cube Rt (cube root) Intensity selections allow you to elevate 

activity occurring between “0” and “1” to the baseline.  Even though the EM100 

(the test subject for these examples) does not provide the random, erratic behavior 

encountered by a live subject (its not supposed to), you can still see the differences 

in intensity provided by these selections in the display examples. 

Figure A-4.  Intensity Selections From the Setup Screen 

Selected Intensity

is: Linear

Selected Intensity

is: Sq Rt

Selected Intensity

is: Cube Rt
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Figure A-5 shows examples of each of the Minimum Visibility selections from the 

Setup screen.  These selections enhance the visibility of the test subject’s 

movements occurring less than 0.01% or 0.001% of the total test time. 

Figure A-5.  Minimum Visibility Selections From the Setup Screen 

Selected Minimum

Visibility is:

Normal

Selected Minimum

Visibility is:

Promote > .01%

Selected Minimum

Visibility is:

Promote > .001%
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A.3  OVERTIME 

This option allows you to view changes in activity over time.  You can chart zone 

metrics (total time, rest time, distance, etc.) for multiple zones.  View how an animal 

or ensembles of animals change as time changes.  This allows establishing baseline 

expectations as well as displaying a view of the changes that a drug causes over 

time. 

A.3.1  Starting OverTime
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Figure A-6.  Starting OverTime 

1.  Select OverTime

2.  Select the Type of data

3.  Select a data file

4.  You end up here



MotorMonitor User’s Manual Appendix A 

Version 7.01 A-9

Figure A-7 is an overtime example reflecting the results of a validation session. 

Figure A-7.  Overtime Examples 
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A.4  PLAYBACK

This option allows you to view the path of an animal, or the EM100 Activity 

Vehicle as if you are watching a video.  This is, essentially, a recording of animal or 

Activity Vehicle movement for an entire session. 

A.4.1  Starting PlayBack

Figure A-8.  Starting PlayBack 

1. Select PlayBack

2. Select a data file

3. You end up here
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A.4.2  PlayBack View Menu  There are three selections on the View menu that

provide visual aids for viewing session data during Playback.  Figure A-9 is a brief

description of these selections.

Figure A-9.  View Menu Show Selections 

Show Events

The event depicted for this test is rearing.

Since the rearing beam interrupter is located

on the rearing frame (which is located above

the activity frame), the event indication is

placed outside the graph area.  The graph is

for the activity frame.  Note that while

PlayBack is running, this indicator changes

color (flashes) at the same rate the rearing

beam interrupter was activated during the

session.

Show XY-Sw

The horizontal and vertical blocks for this

selection represent the X and Y axis beams

on the activity frame.

Show Grid

The resulting grid for this selection

represents the center of the X and Y axis

beams on the activity frame.



MotorMonitor User’s Manual  Appendix A 

A-12 Version 7.01 

There are three selections on the View menu for depicting the shape of the test 

subject.  These three selections are Centroid, Points, and Oval.  In this example 

the subject is the EM100 Activity Vehicle.  Its actual size is the same as the red zone 

shown in these examples.  An example of each selection is provided in Figure A-10. 

Figure A-10.  View Menu Shape Selections 
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A.4.3  PlayBack Setup Menu – Overlay Zone Map  As shown in Figure A-

11, you can overlay the zone map used for this session and see activity relative to

the areas of interest.

Figure A-11.  Zone Map Overlay Example 

1. Select Overlay Zone

Map from the Setup

Menu.

2. Next, this screen will

appear and ask you to

select a zone map.

5. When the zone

map is selected,

click OK.

6. The selected zone map appears as an overlay.

3. Select Browse to select a

Zone Map.

4. Select a Zone Map, then click Open.



MotorMonitor User’s Manual  Appendix A 

A-14 Version 7.01 

A.4.4.  PlayBack Time Selection  You can set the time sliding clocks (Figure

A-12) to view a time-slice within the session, or the entire session, and trace the

path of the subject and print the results.  Another feature, playback speed, allows

you to speed up or slow down the playback function.  The playback speed range is

from 0.1 to 4.0 in 0.1 increments where 1.0 represents the real-time speed of the test

subject.

Figure A-12.  PlayBack Time Selection 

PlayBack start time PlayBack end time

Rewind

Play/Pause

Stop Playback speed

NOTE

This example shows the start and end times for the entire

one-hour session.  You can select any time-slice within the

session.  Remember, when you select a starting time

within the session, the subject will be placed where it was

at that point in time.   The same is true for the end time.
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A.4.5  Enclosure/Parameters – PlayBack Setup Screen  Figure A-13 is an

example of the Playback Setup screen.

Figure A-13.  Playback Setup Screen 

Animal Tracks defines the “length of the tail,” in seconds, and how the tail is 

displayed during playback. 

Displaying the tail from Animal Tracks is accomplished as follows: 

1. First, make sure Centroid is selected from the View menu.  Animal

Tracks only works with Centroid.

2. Next, the duration of the tail, in seconds, must be selected or no tail will

appear (for Track Always and Track Finite) when playback is started.

Duration can only be set when Track Finite is selected.  However the

duration setting, once made, applies to both Track Always and Track

Finite.
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3. Select Track Finite to set the duration and then select the desired Animal

Tracks.

4. Select the width of the track using the up/down arrows from the Width field.

5. The Color button brings up the color palette allowing you to select the color

of the track.

Track Only – Track Only (Figure A-14) displays the end results of all the subjects’ 

movements during the selected time-slice. 

Figure A-14.  Track Only Example 

Track Only
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Track Always –  Track Always (Figure A-15) ends-up being the same as Track 

Only except all the subjects’ movements are visually reproduced during the selected 

time-slice. 

Figure A-15.  Track Always Example 

Track Always
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Track Finite – All the subjects’ movements are visually reproduced during the 

selected time-slice just as they are with Track Always.  The difference is that the 

“tail” does not leave a permanent trace on the display.  The length of the tail is 

determined by the selected duration (Figure A-16). 

Figure A-16.  Track Finite Example 

Track Finite
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APPENDIX B 
SAMPLE ZONE MAPS 

B.1  INTRODUCTION

The following zone map samples are provided as a convenience to familiarize you 

with using zone maps.  

B.1.1  16 X 16 STANDARD OPEN FIELD CAGE RACK – CENTER
VERSUS PERIPHERY

Figure B-1.  16 x 16 Standard Open Field  – Center vs. Periphery 



MotorMonitor User’s Manual  Appendix A 

B-2 Version 7.01 

B.1.2  16 x 16 Standard Plus Maze Zone Map  Notice the dark red Corner

Stretch zone.  This captures the behavior of the subject stretching into the open arms

but not actually entering it.  This technique differs from a poke into the open arm

from the intersection zone.  The corner stretch is one type of Stretch Attend Posture

(SAP).

Figure B-2.  16 x 16 Standard Plus Maze Zone Map 
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B.1.3  7 x 15 High Density Cage Rack – Center versus Periphery

Figure B-3.  7 x 15 High Density Cage Rack – Center vs. Periphery 
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GLOSSARY 

Anchor Beam 

A beam assignment made by the Ambulation algorithm.  There is only one Anchor 

Beam for each dimension, i.e., there is one X Anchor Beam and one Y Anchor 

Beam.  The Anchor Beam is set at the beginning of the session as the lowest 

numbered beam blocked in the dimension.  For example, if X2, X3, & X4 are 

blocked then X2 is the X Anchor Beam.  As the animal makes Ambulations, the 

Anchor Beam is reset.  That is, the Anchor Beam changes only when the current 

Anchor Beam is cleared. 

Ambulation 

A measure used to express larger animal movements, i.e., the subject changed its 

entire body position on the grid.  A brief description of the algorithm follows: an 

ambulation occurs when a new beam block occurs and the anchor beam for that 

dimension is released (cleared) before the new beam.  The anchor beam is the 

lowest beam blocked in that dimension.  For example, if X2, X3 & X4 are blocked 

and then X5 is blocked, the new beam break at X5 will be counted as an ambulation 

if X2 is cleared first.  Otherwise, the break at X5 is recorded as a fine movement. By 

definition, the animal must relocate its whole body to cause an ambulation count.  X 

and Y ambulations are reported separately. 

Basic Movement 

This measure is the simple tally of all horizontal beams in your system.  The 

algorithm is a very simple one; the Basic Movement counter is incremented upon 

each new Beam block.  When the beam (or switch) is cleared is irrelevant.  

Beam Break 

This is the occurrence of a photobeam pair being blocked.  The opposite of Beam 

Cleared. 

Beam Cleared 

Normal condition when there is no obstruction between the Light Emitting Diode 

(LED) and the Phototransistor.  The opposite of Beam Break. 
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Centroid 

The calculated center of the animal based on beam breaks.  As an example if beams 

X3, 4, & 5 or broken and Y1 & 2 are broken, the subject’s centroid is calculated as 

X4, Y2.5 

Debounce 

A software tool used to eliminate any erroneous beam breaks caused from electrical 

power line noises.  The system collects data samples every 50 milliseconds.  When 

Debounce is on, there must be at least two consecutive breaks before the break is 

actually registered.  Typically we recommend having Debounce set to off, i.e., 

debounce is not checked. 

Default Files/Folder 

A set of related system files and folders that are loaded when the MotorMonitor 

software is first initiated.  There are two folder locations; the application folder that 

contains the Enclosure configuration, Session template, and Zone map and all raw 

session data files and output reduction files folder that contains all reduced output 

files.  Additionally you can set the Enclosure configuration, Session template, and 

Zone map files the system defaults to. 

Enclosure Configuration 

A file containing a translation table defining the location and purpose of each beam 

used in the system.  These files are factory set.  There is typically only one such file 

per system. If more than one configuration file is needed, then the user can create 

enclosure configuration files to fit his or her specific needs.  However, enclosure 

configuration file creation requires administrative privileges. 
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Fine Movement 

A measure used to express smaller animal movements, i.e., the subject changes a 

beam status but the change does not fit the definition of an ambulation.  One 

example would be a single beam changing status while no other beams changed 

status.  There are more complex Fine Movements such as head weaves. For 

example, if an animal is repeatedly moving its head from left to right and back 

again; it could alternately break beams on the left and right sides of its head.   Fine 

Movements are used to report movements such as grooming and/or head 

movements.  The Fine Movement counter is incremented because of the Beam 

status change not meeting the Ambulation algorithm.  That is, there is no specific 

test for Fine Movements. 

Fine Count Holdoff 

A parameter used to reduce erroneously high counts because the animal is sitting 

just on the edge of a beam.  Photobeams are analog devices, therefore, you can 

partially block a beam and with the slightest movement cause the beam to alternate 

between cleared and blocked.  If such a situation is occurring, you can set this 

variable higher to reduce its affect on the data.  That is, fine movements will be 

incremented at no higher rate than one per n seconds, where n is the setting of the 

fine count holdoff. 

Interval 

A user-defined time partition used during data analysis.  Each data reduction effort 

results in data being sectioned into time "intervals."  In this way, a user can study 

measures for each of the intervals reported.   

NOTE 

It is very important to remember that the system does not 

report partial intervals, i.e., any time slice less than a 

complete interval will have NO data reported in the output 

reduction file. 
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Output Reduction File 

This file is created by funneling any variety of data files into one reduction file.  The 

resulting reduction file will then contain all the requested measures.  It is a comma-

delimited file especially set up for easy export into spreadsheets or statistical 

programs. 

Pre Pause 
Provides a pause within a Session. Normally used when test subject requires dosing 

with two drugs for one session. 

Rest Time Threshold 

Provides the user the ability to define what “at rest” means.  The setting determines 

whether an individual scan (50 milliseconds) is added to the Total Rest Time. 

Consider the following sequence: 

1. The Rest Time Threshold is set to 1 second.

2. All Beam Breaks are followed by an X or Y Beam Break in less than one

second.

This example results in the Total Rest Time Counter reporting zero seconds. 

Alternatively, consider this sequence: 

1. The Rest Time Threshold is set to 1 second.

2. One Beam Break is followed by 1.2 seconds before the next X or Y Beam

Break.

3. A second Beam Break is followed by 2.5 seconds before the next X or Y

Beam Break.

This example results in the Total Rest Time Counter reporting 3.7 seconds. 

In other words the Total Rest Time counter tallies all pauses of activity that last for 

at least the value of the Rest Time Threshold setting. 
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Session 

A complete data collection sequence for all enclosures listed in a single-session data 

file. Put simply, the data collected from a single press of the start button of each 

enclosure selected for that session. 

Session File 

A binary file containing all the header information entered by the user including 

duration, session parameters, enclosure information, and the actual beam break 

information that occurred during the session. 

Session Template 

A file containing commonly used header information.  The user can create a variety 

of session template files and store them away for repeated later use.  This is a time 

saving technique to help save the user from repetitive typing of commonly used 

information.  Typically contains duration, session description, session information 

labels and data, and enclosure information labels and data. 

Total Rest Time 

The total amount of time the animal remained inactive (change any beam status) as 

defined by Rest Time Threshold.  Reported per zone per interval. 

XY Smoothing 

A parameter that affects distance traveled.  Imagine the animal is traveling at exactly 

a 45-degree path across an open field.  Theoretically, the system should draw a line 

45-degree angle to the X and Y dimensions.  However, a problem arises because the

system takes samples every 50 milliseconds.  It is highly unlikely that the animal

will break both the X and the Y dimensions at precisely the same time.  Without

some adjustment the system will believe that the animal commuted in only one

dimension at a time and therefore cause the distance to be erroneously high.  To

compensate for this we have established a parameter called smoothing.  The system

waits for the amount of time set by the user (n seconds) before determining the next

location to calculate the distance traveled.  That is, the system waits for n seconds to

see if the animal reaches (breaks a beam) in the other dimension.
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Zone Map 

An overlay created by the user to define areas of the enclosure for data analysis.  A 

simple example would create four equal quadrants in an open field.  Each zone will 

have data compiled for it during data reduction, i.e., information will be reported for 

time active vs. time at rest, distance traveled, entries, etc.  




